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序文 

本マニュアルについて 

このマニュアルは、FEMtools 3.5 における新しい機能、機能強化、および訂正について記述したものです。 

FEMtools マニュアルにおいて使用される規則 

FEMtools マニュアルは、視覚的に情報を識別するのに便利なように、いくつかの規則を設けています。 

タイプのスタイルまたは記号          用途                     
extract nodes FEMtools コマンドラインの例 
SET ECHO FEMtools コマンドまたはコマンドの構文 
Settings メニュー・コマンド 

統一性と UNIX プラットフォームでの大文字／小文字の区別を考慮して、FEMtools コマンド・スクリプトに

おけるすべてのコマンドと引数（特にファイル名）に対して小文字が使用されています。しかし、FEMtools
のドキュメンテーションでは、読み易くするためにコマンドは通常大文字で記されています。 

関係のあるドキュメンテーション 

本マニュアルは、次のマニュアルと一緒に用いるのがよいでしょう。 

• FEMtools 入門マニュアル 

ドキュメンテーションの使用について 

FEMtools ドキュメンテーションは、HTML ベースのヘルプとして、および PDF フォーマットでのオンライン

マニュアルとして利用できます。 

ヘルプにアクセスするには、Help メニューから Help Topics を選びます。 

• 全マニュアルの目次の完全なリストを見たい場合は、Contents タブを使います。 
• すべてのインデックスエントリのリストを見たい場合は、Index タブを使います。 

その他のタブは、使用するオペレーティング・システムに依存して利用することができます。 

マニュアルにアクセスするには、Help メニューから Manuals を選んでください。PDF ファイルを読むには、

Adobe Acrobat Reader がシステムにインストールされなければなりません。 
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FEMtools 3.6の紹介 

FEMtools 3.6は、新たな動解析機能（パデ近似法、FRFベースのアセンブリ、時間領域シミュレーション）お

よびプリテスト解析機能が搭載されたFEMtoolsソフトウェアのメジャーなアップデート・バージョンです。

また、モーダル・パラメータ・エクストラクター（MPE）アドオンツールも新たな対話形式アプレットにア

ップグレードされました。 

このリリース版のハイライトを以下に示します。 

パデ近似法 

周波数応答関数（FRF）はパデ近似を使用し計算することができます。この方法は、モーダルアプローチ（高

速性）およびダイレクトプローチ（連続性、減衰モデル）の利点を組み合わせます。パデ・プロセスはFRF
周波数レンジを分割し、いくつかのより小さな周波数帯（バンド）での注目するすべての周波数ラインに対

するソリューションに拡張するために各バンドの中心にオーダーnまでの直接的なFRFの勾配の計算と同様

のFRFソリューションを使用します。これは、ダイレクト・ソリューション数の縮小に帰着し、200の関数に

おいて、高速化が実感されます。パデ近似は、すべての周波数ラインでの直接的ソリューションと比較して

もその精度誤差は微少です。 

FRFベースのアセンブリ 

FEMtools 3.6はFRFベースのアセンブリ（FBA）によるサブストラクチャリング機能を搭載します。このFBA
は多数の潜在的なコンポーネントを組み合わせ、計算で求められたFRFや各コンポーネント上の測定データ

を使用し、アセンブリ・レスポンスを推定します。FBAは、構成要素のモード合成関数（スーパー要素：CMS）
およびモード・ベースのアセンブリ（モードシェープを使用）に取って代わります。 

時間領域シミュレーション 

FEMtools 3.6は時間領域シミュレーション（動解析の新しいツール）を搭載します。 

時間領域シミュレーション（TDS）技術は適用荷重関数の構造過渡応答を計算することを可能にします。

FEMtools TDSソルバーは、最初に構造物の正規モードから定常空間モデルを導き出し、次に時刻歴応答デー

タを計算するためにこのモデルを使用します。そのため、TDSソルバーは、新たなFEソルバーを実行するこ

となく、効率的な計算方法で過渡応答を推定します。 

また、TDSのモジュールは、FEMtoolsモーダル・パラメータ・エクストラクター（MPE）と組み合わせ、プ

リテスト解析ツールとして使用することもできます。TDSのモジュールは、測定チャンネルのダイレクト出

力（即ち、時刻歴）データを取り扱うことができます。したがって、プリテスト解析は実際の測定データの

シミュレーションからスタートし、完全なテスト手順を評価するために使用することができます。 

プリテスト解析 

• 選択センサーは、Rotate Sensors パネルから「回転」することができます。 
• MAC（SEAMAC）によるセンサー除去機能は、1セットの固定センサー位置を使用することができます。 
• このルーチンは、SEAMAC技術の非対角項のMAC値にターゲット値を指定し、非対角項の値を指定され

た値より低くい最も小さなモデル（最小数のセンサー）を推定します。 

モーダル・パラメータ・エクストラクター・アドオン 

FEMtools MPE（モーダル・パラメータ・エクストラクター）の新しい対話形式のアプレットには、FRF選択、

周波数バンド選択、複数バンド選択、複素プロットなどが追加されました。FEMtools MPEは、1セットの周

波数応答関数（FRF）やクロスパワースペクトルからモーダル・パラメータを抽出するためのアドオン・モ

ジュールです。 
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拡張スクリプト関数 

コマンド・スクリプトには、26の新しいコマンドが追加されました。プログラマは、それらの新しいFEMtools
スクリプト関数やFEMtools API関数によって、より有益な利用方法が考えられます。 

FE データ・インターフェイスの更新 

FEプログラムのインターフェイス、ドライバがユーザー・リクエストに基づいて更新されました。特に、

NASTRANとANSYSインターフェイス・プログラムは、最新のNastran 2012およびANSYS 14のリリースに伴

いサポートされました。 
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FEMtools 3.6ドキュメントとトレーニング 

FEMtools 3.6ドキュメントは、電子ヘルプ、コース・ノート、電子ブック（PDF）および印刷されたマニュア

ルから成ります。 

ドキュメントはすべて現在のリリースに行なわれた変更を反映するために更新されました。 

新規ユーザーにおいて、より高度な解析とテストの技術を習得するためのコースについての情報が提供され

ます。 

 

ドキュメント概説 

FEMtools 3.6ドキュメントは次のように構成されます。 

• FEMtools 3.6リリースノート（ Release Notes） ：このマニュアルは、FEMtools 3.6の新機能および既存バ

ージョンからのアップグレード方法などについて解説します。 

• FEMtools 3.6導入ガイド（Getting Started Manual）：このマニュアルは、FEMtoolsシステムのインストー

ル、ライセンス設定、起動などの方法について解説します。 

• FEMtools 3.6フレームワーク・ユーザガイド（Framework User's Guide）：このガイドは、FEMtoolsのユ

ーザー・インターフェイス、データベース、データ・インターフェイス、スクリプト言語、グラフィック

スなどのモジュールに関する詳細を解説します。 

• FEMtools 3.6メッシュ・ユーザーガイド（Mesh User's Guide）：このガイドは、メッシュ生成、メッシュ

変形、要素定義、メッシュ定義などのメッシュ・ツールに関する情報を解説します。 

• FEMtools 3.6ダイナミクス･ユーザーガイド（Dynamics User's Guide）：このガイドは、FEMtoolsによる

構造ダイナミクス・シミュレーションの理論的背景を解説し、また実際例を紹介します。 

• FEMtools 3.6プリテスト解析、相関分析ユーザーガイド（Pretest and Correlation Analysis User's Guide）：

このガイドは、プリテスト解析、相関分析に関する理論的背景を解説し、また実際例を紹介します。 

• FEMtools 3.6モデルアップデート・ユーザガイド（Model Updating User's Guide）：このガイドは、感度

解析、モデルアップデート、外力同定および確率論的解析の実際例を紹介します。 

• FEMtools 3.6モデルアップデート理論マニュアル（Model Updating Theoretical Manual）：このマニュア

ルは、モデルアップデートの理論的背景およびFEMtoolsモデルアップデートに伴う誤差解析法やツールに

ついて解説します。 

• FEMtools 3.6モデルアップデート例題マニュアル（Model Updating Examples Manual）：FEMtoolsモデル

アップデートによる材料特性、幾何学特性などのモデルアップデート実際例を紹介します。 

• FEMtools 3.6最適化ユーザーガイド（Optimization User's Guide）：このガイドは、一般非線形プログラミ

ングによる構造最適化およびサイズ、形状のトポロジーとトポメトリーの最適化のようなDOE/RSMとア

プリケーションに関する理論的背景を解説し、また実際例を紹介します。 

• FEMtools 3.6モーダル・パラメータ・エクストラクター・ユーザーガイド（Modal Parameter Extractor 
User’s Guide）：このガイドは、デジタル信号処理機能とモーダル・パラメータ抽出方法に関する実際例

を紹介します。 

• FEMtools 3.6剛体プロパティ・エクストラクター（Rigid Body Properties Extractor User’s Guide）：この

ユーザーガイドは、理論的背景、周波数応答関数（FRF）から剛体プロパティを抽出する方法に関する実

際例を紹介します。 

• FEMtools 3.6 ARTeMISインターフェイス・ユーザーガイド（ARTeMIS Interface User's Guide）：このガ

イドは、ARTeMISファイルのインポートとエクスポートの方法に関して解説します。 

• FEMtools 3.6 ABAQUSインターフェイスとドライバ・ユーザーガイド（ABAQUS Interface and Driver 
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User's Guide）：このガイドは、ABAQUSファイルのインポートとエクスポートの方法に関して解説しま

す。 

• FEMtools 3.6 ANSYSインターフェイスとドライバ・ユーザーガイド（ANSYS Interface and Driver User's 
Guide）：このガイドは、ANSYSファイルのインポートとエクスポートの方法に関して解説します。 

• FEMtools 3.6 NASTRANインターフェイスとドライバ・ユーザーガイド（NASTRAN Interface and Driver 
User's Guide）：-このガイドは、NASTRANファイルのインポートとエクスポートの方法に関して解説し

ます。 

• FEMtools 3.6 UNIVERSAL FILEインターフェイスとドライバ・ユーザーガイド（UNIVERSAL FILE 
Interface and Driver User's Guide）：このガイドは、ユニバーサル・ファイル・フォーマットを使用した

FEAとテストデータのインポートとエクスポートの方法に関して解説します。 

• FEMtools 3.6のSAP2000インターフェイス・ユーザーガイド（SAP2000 Interface User's Guide）：このガ

イドは、SAP2000ファイルのインポートとエクスポートの方法に関して解説します。 

• "FEMtools 3.6プログラマガイド（Programmer’s Guide）：このマニュアルは、FEMtoolsスクリプト・リ

ファレンス・マニュアル、APIリファレンス・マニュアルおよびアプリケーション・プログラムの例証を

紹介します。 

• FEMtools 3.6 GUIリファレンス（GUI Reference）：これは、メニュー、ツールバー、ダイアログボック

スに関する情報を含む電子リファレンス・マニュアルです。 

• FEMtools 3.6コマンドリ・ファレンス（Command Reference）：これは、FEMtoolsコマンド言語の情報、

シンタックス、引き数および例題を含む各コマンドについての詳細な情報を含む電子リファレンス・マニ

ュアルです。同様のバージョンはソフトウェアにも含まれています。 

• FEMtools 3.6スクリプト・リファレンス（Scripting Reference）：これは、FEMtoolsスクリプト言語（変数、

演算、関数、ステートメント）に関する電子リファレンス・マニュアルです。同様のバージョンはソフト

ウェアにも含まれています。 

• FEMtools 3.6アプリケーション・プログラム・インターフェイス（API）リファレンス（Application 
Programming Interface (API) Reference）：これは、FEMtoolsデータベースを解説する電子リファレンス・

マニュアルです。同様のバージョンはソフトウェアにも含まれています。 

次の表は、現在リリースされているマニュアルの一覧です。 

Document Name  Format  

FEMtools 3.6 Getting Started Manual  PDF, Help  

FEMtools 3.6 Release Notes  PDF  

FEMtools 3.6 Framework User's Guide  PDF, Help  

FEMtools 3.6 Mesh User's Guide  PDF, Help  

FEMtools 3.6 Dynamics User’s Guide  PDF, Help  

FEMtools 3.6 Pretest and Correlation Analysis User’s Guide  PDF, Help  

FEMtools 3.6 Model Updating User’s Guide  PDF, Help  

FEMtools 3.6 Model Updating Theoretical Manual  PDF  

FEMtools 3.6 Model Updating Examples Manual  PDF  

FEMtools 3.6 Optimization User’s Guide  PDF, Help  

FEMtools 3.6 Modal Parameter Extractor User’s Guide  PDF, Help  
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FEMtools 3.6 Rigid Body Properties Extractor User’s Guide  PDF, Help  

FEMtools 3.6 ARTeMIS Interface User’s Guide  PDF, Help  

FEMtools 3.6 ABAQUS Interface and Driver User’s Guide  PDF, Help  

FEMtools 3.6 ANSYS Interface and Driver User’s Guide  PDF, Help  

FEMtools 3.6 NASTRAN Interface and Driver User’s Guide  PDF, Help  

FEMtools 3.6 UNIVERSAL FILE Interface and Driver User’s Guide  PDF, Help  

FEMtools 3.6 SAP2000 Interface User’s Guide  PDF, Help  

FEMtools 3.6 Programmer’s Guide  PDF  

FEMtools 3.6 GUI Reference Manual  Help  

FEMtools 3.6 Command Reference Manual  Help  

FEMtools 3.6 Scripting Reference Manual  Help  

FEMtools 3.6 API Reference Manual  Help  

ヘルプ（Help）は、FEMtoolsヘルプ・メニューからアクセス可能なドキュメントを参照し、そのヘルプとし

てMicrosoft HTMLヘルプ（Windows）およびHTLM（LinuxとMac OS）が使用されます。 

PDFはAdobe Acrobatポータブル文書フォーマット（PDF）を参照します。これらのファイルは、アドビ・シ

ステムズ（www.adobe.com）からダウンロード可能なAdobe Readerソフトウェア、Windows用ユーティリィテ

ィ、Unix、Linuxを使用して読むことができます。Adobe AcrobatからPDFフォーマットのマニュアルを印刷す

ることができます。また、電子マニュアルにアクセスするには、HelpメニューからManualsを選択してくだ

さい。 

 

FEMtoolsトレーニング・コース 

DDS（Dynamic Design Solutions）とFEMtoolsソルバーパートナーは、上級ユーザーやFEMtoolsアプリケーシ

ョン開発者のためのコースと同様に新規ユーザーのためのイントロダクション・コースも提供しています。 

それらのより詳細については、support@femtools.com にお問い合わせください。また、その最新情報につい

ては、http://www.femtools.com/courses から閲覧することもできます。 

 

mailto:support@femtools.com
http://www.femtools.com/courses
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FEMtools 3.6更新情報 

 

インストール、ライセンス、構成 

サポート・オペレーティング・システムと最小インストール条件を次に示します。 

FEMtools 3.6プラットフォーム・サポート 

次の表は、FEMtools 3.6のサポート・プラットフォームを示します。 

プラットフォーム  オペレーティング・システム  プロセッサ 
WIN32  Windows XP, Vista 32-bit, Windows 7 

32-bit  
Intel x86; AMD 32  

WIN64  Windows XP Pro 64-bit, Vista 64-bit, 
Windows 7 64-bit  

Intel EMT64; AMD 64  

LIN64  Red Hat, SUSE 64-bit,…  Intel EMT64; AMD 64  
MAC64  Mac OS X 10.5 or higher (64-bit)  Intel x86  

サポート・プラットフォームに関する最新情報は、FEMtoolsウェブサイト（http://www.femtools.com）を参照

してください。 

最小インストール条件 

Windows 

• Microsoft WindowsXP、MicrosoftVista、MicrosoftXP Pro 64ビット、Microsoft Vista 64ビット、Windows7（32
ビット、64ビット） 

• 最小RAM：1 GB 
• 250MB以上のハードディスク・スペース 
• OpenGLをサポートするグラフィックスカード：グラフィックスカード・ハードウェアが高速OpenGLをサ

ポートする場合には、グラフィックス性能も向上します。 
• CDや電子メールからインストールするためのCD-ROMドライブ、インターネット接続 
• USBポート（節点ロック・ライセンス・オプション用） 
• ライセンスサーバー用TCP/IP接続（フローティング・ライセンス・オプション用） 
• Adobe Acrobat Readerあるいは類似アプリケーション（PDF電子ドキュメントを読むため） 

Linux 

• Red Hat Linux 9.0+（SUSE 9.0+） 
• 最小RAM：1 GB 
• 250MB以上のハードディスク・スペース 
• OpenGLをサポートするグラフィックスカード：グラフィックスカード・ハードウェアが高速OpenGLをサ

ポートする場合には、グラフィックス性能も向上します。 
• CDや電子メールからインストールするためのCD-ROMドライブ、インターネット接続 
• USBポート（節点ロック・ライセンス・オプション用） 
• ライセンスサーバー用TCP/IP接続（フローティング・ライセンス・オプション用） 
• Adobe Acrobat Readerあるいは類似アプリケーション（PDF電子ドキュメントを読むため） 

Mac OS X 

• x86プロセッサ用Mac OS X 10.5+ 
• 最小RAM：1 GB 
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• 250MB以上のハードディスク・スペース 
• CDや電子メールからインストールするためのCD-ROMドライブ、インターネット接続 
• USBポート（節点ロック・ライセンス・オプション用） 
• ライセンスサーバー用TCP/IP接続（フローティング・ライセンス・オプション用） 
• Adobe Acrobat Readerあるいは類似アプリケーション（PDF電子ドキュメントを読むため） 

インストールに関する変更点 

• アドオン・マネージャーは、インストール/アンインストールのアドオン機能が改善され、インストール/
アンインストール操作が容易になりました。アンインストール手続きも改良され、より安定したパッケー

ジ・マネージャーとして提供されます。 

Windows 

• デフォルトでは、FEMtools 3.6はディレクトリC:￥FEMtools￥3.6（Windows）にインストールされますが、

インストール・ディレクトリはインストール中に変更することができます。インストール・パスにブラン

クを含ませることも可能です。 
• アクロバット・リーダ・インストーラーは、もはやFEMtoolsインストールCD-ROMシステムには同梱しま

せん。また、任意のPDFリーダがFEMtoolsマニュアルをオープンするために使用することができます。 
• FEMtoolsインストールD-ROMには、Sentinel Advance Medic（SAM）ユーティリィティ・インストーラー

を同梱しています。このユーティリィティは、SentinelSuperproドングルおよびそのコンポーネントが適切

にインストールされるように検知するために使用されます。さらに、SAMを使用することにより問題を解

析するためのファイルを記録することができます。SAMの最新バージョンは、www.safenet-inc.comからダ

ウンロードすることができます。 

Mac OS 

• Mac OS X用のインストール・パッケージは、DMGファイル（ディスク・イメージ）として配布されます。

これには、FEMtoolsインストール・システム・ファイルと例題のパッケージが含まれ、システム・ファイ

ルはアプリケーション・フォルダにインストールすることができます。例題フォルダには書き込みライセ

ンスが必要とされ、それによってすべてのユーザーによってアクセスすることが可能です。それらは、

MACシステムの任意の場所に保存することもできます。 

ライセンスに関する変更点 

• FEMtools 3.6は、ライセンス管理にRLM 9.3を使用します。その詳細に関しては、RLMドキュメントを参

照してください。 
• インストール・パッケージは、Safenet社のSuperproドライバ（v7.6.5 for Windows、v7.6.0 for Linux、v7.5.2 for 

Mac OS X）を含んでいます。 
• アドオン・ライセンスが利用可能で、そのアドオンがまだインストールされてないことが検知されるとア

ドオン・インストーラが自動的にスタートアップされます。 
• FEMtools 3.6は、FEMtools 3.4.xやv3.5.xのバージョンで使用された期限付きライセンス・キーを使用するこ

とができます。それらには年間およびトライアルのライセンスがあります。それらのユーザーは新たなラ

イセンスファイルを必要としません。 
• 旧バージョン用の永年ライセンスは、FEMtools 3.6と互換性がありませんので、新たなライセンスを必要

とします。 
• 初期のバージョン（v3.3.x以前）からアップグレードする場合には、新しいライセンスファイルが必要で

す。 
• 既存のライセンスがFEMtools 3.6で有効でない場合はメッセージが表示されます。ライセンス・ステータ

スに関する情報および新しいFEMtoolsに3.6のライセンスを得るには、licensing@femtools.com にお問い合

わせください。 
• Help > License Information コマンドは、もはやライセンスのチェックを行いません。それはライセンス

が設定されているかのみチェックします。 
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FEMtools旧バージョンからアップグレード 

以下は、FEMtoolsの旧バージョンからFEMtools 3.6にアップグレードを希望するユーザーにおいて重要な情報

です。 

• FEMtools 3.6をインストールする場合、新しいディレクトリにインストールすることを推奨します。（デ

フォルトでは、C:¥FEMtools¥3.6） 
• 永久ライセンスを有し、初期のバージョン（v3.3.x以前）を使用しているユーザーがアップグレードする

場合には、新しいライセンスファイルが必要です。FEMtools 3.4.x/3.5.xの年間ライセンスは使用している

ユーザーはその有効期限まで既存のライセンスファイルで利用することができます。 
• 最初にこのバージョンを開始する場合には、新しいセッティング・ファイルがホームディレクトリーに作

成されます。以前にインストールされている環境では、既存のセッティング・ファイルをスタートアップ

上の新しいセッティング・ファイルとして自動的にコピーすることができます。 
• 旧バージョンで使用されたドライバ・スクリプトのドライバ・セッティングやその修正は、FEMtools 3.6

に自動的には復旧されません。それらのドライバ用に行なった修正は、FEMtools 3.6バージョンのINIファ

イルやBASドライバ・スクリプトにおいて繰り返さし設定し直さなければなりません。それらのファイル

は、<installdir>¥scripts¥driversに保存されています。 
• ヘルプのコマンド・リファレンス・セクションおよびFEMtools 3.6リリースノートのFEMtoolsコマンド言

語（command language）の変更点を確認し、必要に応じてコマンド・スクリプトを更新してください。 
• ヘルプのAPIリファレンス・セクションおよびFEMtools 3.6リリースノートのFEMtools APIの変更点を確認

し、必要に応じてプログラム・スクリプトを更新してください。 
• 「FEMtools 3.xプロジェクト・ファイルは、FEMtools 3.6にインポートすることができます。 
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ドキュメントと例題の変更点 

次の主な変更がドキュメントと例題のディレクトリに行われました。 

• FEMtools相関分析ユーザーガイド（Correlation User’s Guide）は、FEMtoolsプリテスト解析と相関性ユ

ーザーガイド（Correlation Analysis User’s Guide）に変更されました。 
• FEMtools 3.6モーダル・パラメータ・エクストラクター・ユーザーガイド（Modal Parameter Extractor 

User’s Guide）には、以前は個別のユーザーガイドだったデジタル信号処理（DSP:Digital Signal Processing）
のドキュメントが統合されました。 

• FEMtools 3.6ダイナミクス・ユーザーガイド（Dynamics User’s Guide）は、FRFベースのアセンブリおよ

び時間領域シミュレーションについての新しい章が追加されました。パデ近似の情報がFRFシンセシスの

章に追加されました。新しい解析ツールを例証する例題がドキュメント化されました。 
• 新しい例題のサブディレクトリが動解析（dynamic analysis）として追加されました。

（...¥examples¥dynamic¥fba, ...¥examples¥dynamic¥pade and ...¥examples¥dynamic¥tds） 

 

データ・インターフェイスおよびドライバ・プログラム 

データ・インターフェイス・プログラムの変更の概観は今後リストされます。 

ABAQUSインターフェイスとドライバ 

• ドライバ・エラー・レポートが改善されました。 

ANSYSインターフェイスとドライバ 

• ANSYS 14のサポートが追加されました。 
• ドライバ・エラー・レポートが改善されました。 

NASTRANインターフェイスとドライバ 

• OUG1カードは、POST, -1, op2でサポートされます。OUG1カードはOUGV1カードに取って代わります。 

ユニバーサル・ファイル・テスト・データ・インターフェイスとドライバ 

• IDEASインターフェイスの未定義だった要素のサブタイプが固定されました。 
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データベースの管理 

このセクションは、FEMtools 3.6リリースでデータベース管理の変更点について解説します。 

サーフェイスの正規方向に基づいた節点選択 

節点選択シンタックスは、サーフェイスの正規方向に基づく指定ベクトル（nx、ny、nz）に平行な節点を選

択するための新しい補語 NORMAL をサポートされます。その方向は正規化された0.999のスカラー積より平

行と考えられ、また符号（サイン）は考慮されません。そのシンタックスは次のとおりです。 

.... NODE NORMAL nx ny nz ....  

次の例は、グローバルなZまたは、-Zの正規方向の節点のすべてを抽出します。 

EXTRACT NODE NORMAL 0 0 1  

ノイズ生成 

ノイズ生成ルーチンは、実験周波数にノイズを加えることができます。ノイズは、GUI（Database > Advanced 
> Add Noise）を使用し、かつ、NOISEコマンドを使用して周波数に加えることができます。 

マトリックスのインポートとエクスポート 

LOAD MRECとSAVE MRECのコマンドは、EXPORT MATRIXとIMPORT MATRIXのコマンドと取り替えられ

ました。 

いくつかのマトリックスもメイン・メニュー（File > Export > FEMtools Matrices）およびデータベース・エ

クスプローラ（マトリックス・エントリのポップアップ・メニュー中のExport Matrix）からアクセスしたMatrix 
Exportダイアログボックスを使用し、エクスポートすることができます。 

 

Matrix Export  ダイアログボックス 
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グラフィックス 

ワイヤーフレームのソリッド・ビュー 

パイプ要素を使用した3Dのソリッド・ビューを使用し、ワイヤーフレーム・モデルを表示することができま

す。カラーがトレースラインのグループに割り当てられる場合、それらのカラーでプロットに使用されます。

これにより複雑なテスト・モデルを表示する場合に有効です。 

ソリッド・ビューをアクティブにするには、MESHコマンドの補語の PIPE [ON | OFF] を使用する。 

グループのカラーコードを使用して表示するには、GROUPという補語を使用します。 

 

 

自動車のワイヤーフレーム・メッシュとソリッド・ビュー 

新しいFRFカーブ・プロット 

FRFは、新たに追加された3つのカーブ・タイプを使用し、プロットすることができます。 

• Real-Imaginary：実数部/虚数部のプロット 
• Bode：ボードプロット（マグニチュウドと位相） 
• Nyquist：ナイキスト・プロット（実数部と虚数部の関数）  

FRFを表示には、グラフィックス・ウィンドウ・ツールバーのカーブ・タイプ・リストボックスを使用しま

す。 

新しいプロットの例を次に示します。 



12 
 

 

 

 

新しいFRFカーブ・プロット：Real-Imaginary（上段）、Bode（中段）、 Nyquist（下段） 

 

ユーザー・インターフェイス 

本章は、FEMtoolsメニュー・インターフェイスの変更点について解説します。 

コンソール・ウィンドウ 

• UpとDownの矢印キーによってコマンド・エントリ・ラインのコマンド・ヒストリ（過去の実行コマンド）

をナビゲートする機能が使用できます。これはテキストをコマンド・エントリ・ラインにタイプインする

場合、コマンド・ヒストリのナビゲートにおいてコンソール・ウィンドウにタイプされたテキストで始ま

るコマンドだけがリストされます。これは、その指定の接頭辞と一致する以前にタイプされたコマンドの

迅速な検索を可能にします。 
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• プログラム・スクリプトのコンパイル時間が、SET DEBUG VERBOSE ON コマンドで示されます。 

グラフィックス・ウィンドウ 

• ズーム、移動、ピック追加、ピック削除（Zoom、Pan、Pick Add、Pick Remove）の操作ごとに異なるカー

ソルタイプが使用されます。これによってマウスの左ボタンに割り当てられている操作も容易に認識でき

ます。 
• MAC寄与度解析（MCA：Modal Contribution Analysis）は、非対角項の値の表示を改善するために「ダイ

ヤモンド」ビューを使用し、MACマトリックスをプロットします。 

 

非対角項値の表示を改善したマトリックス「ダイヤモンド」ビュー 

エクスプローラ 

• Export Matrix コマンドがテーブル・データベース・エクスプローラのマトリックス・エントリ用のポッ

プアップ・メニューに追加されました。 
• Clear Matrix コマンドがテーブル・データベース・エクスプローラのマトリックス・エントリ用のポップ

アップ・メニューに追加されました。 

スクリプト 

• 新しいユーティリィティがFEMtoolsコマンド・スクリプトをFEMtoolsプログラム・スクリプトに変換する

ために付け追加されました。そのcmdtobas.basスクリプトは、/scripts/utilitiesフォルダに保存されています。

コンソール・ウィンドウのコマンド・エントリ・ラインで、HELP CMDTOBASとタイプし、追加情報を

見ることができます。 

新しいメニュー・コマンド 

次のメニュー・コマンドが、FEMtools3.6に追加されました。 

File > Export > FEMtools Matrices  マトリックスのファイルへのエクスポート 

Pretest Analysis > Rotate Sensors   Rotate Sensors パネルのオープン 

修正されたメニュー・コマンド 

Pretest Analysis > Manual Pretest Analysis Manual Sensor Selection がリネームされました。 
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解析 

解析モジュールの主な変更点を以下に解説します。 

応力解析 

• STRESSコマンドは、節点応力を計算できるように拡張されました。 

Manual Sensor Rotation （マニュアル・センサー回転/プリテスト解析） 

センサーは、Rotate Sensorsパネルから回転することができます。センサーの回転座標系は、センサー節点、

軸節点、平面節点の3つの節点の指定により定義することができます。センサー節点は、センサーの座標系に

おける原点からのセンサー位置を定義します。軸節点は座標系の軸のうちの1つを定義し、センサー節点から

軸節点の位置を指します。平面節点はセンサー座標系の平面を定義するために使用されます。その平面は、

センサー、軸、平面節点を通り抜けます。 

Rotate Sensors パネルをオープンするには、メニューから、Tools > Pretest Analysis > Rotate Sensors を選択

します。 

 
 

（a） 

 

（b） 

図(a)は、FEモデルのグローバル座標系と節点位置を示し、図（b）はローカル座標系のたセンサー方向を示

します。 

新しい例題が、FEMtools Pretest and Correlation Analysis User’s Guide （プリテスト解析と相関分析のユーザー

ガイド） に追加されました。Manual Rotation of Sensors Example（センサー手動回転の例題）を参照してくだ

さい。 



15 
 

Rotate Sensors パネルのより詳細については、Helpボタンを使用し、参照してください。 

マニュアル・センサー選択（解析をプリテスト解析する） 

• 手動のセンサー選択は、パネルで操作され、グラフィックス・ウィンドウのすべてをコントロールします。 
• 特定のモードに対して使用することができます。 
• MACマトリックス再計算のオン/オフを切り替えることができます。 
• 別の節点にセンサーを移動させることができます。 

MAC（SEAMAC）によるセンサー除去（プリテスト解析） 

• SEAMAC技術によって1セットの固定センサー位置を使用することができます。 
• SEAMACルーチンは、手動のセンサー選択モジュールと互換性をもち、手動の選択は、SEAMACの出発

点として使用することができます。また、SEAMAC結果は直ちに手動のセンサー選択パネルに反映されま

す。 
• SEAMAC技術の非対角項のMAC値にターゲット値を指定することが可能です。このルーチンは、非対角

項の値を指定された値より低くなるような最小モデル（最小センサー数）を推定します。そのSEAMAC
技術により、最小センサー数を推定することができます。 

• そのアルゴリズムを実行する前に、SEAMAC技術に伴う候補センサー位置を視覚化することができます。 
• SEAMACによるセンサー選択とmanual sensor selection（手動センサー選択）ダイアログボックス操作は、

パネルによって実行されました。このパネルはGUI機能を中断せず、結果のプロットを確認するためのす

べてのコントロールが可能です。また、パネルはセンサー選択アルゴリズムを開始後においてもクローズ

せず、連続的な実行が可能です。 

一般プリテスト解析 

• FEモデルに要素を含んでいない場合でも、NMD、EIM、SEAMACセンサー選択技術を使用することがで

きます。だし、FEデータベースにはモードシェープを含んでいなければなりません。それらの実行には要

素質量マトリックスを必要とし、また要素がない場合には、NKEとIGRの計算は実行することができませ

ん。 
• PRETEST CLEAN コマンドは、プリテスト解析後のFEモデルを消去するために追加され、不必要な座標

系を削除します。 
• EXAMINE DIRCOSコマンドは、座標系あるいは測定センサーの方向余弦を計算するために追加されまし

た。 
• PRETEST REPORT コマンドでは、方向余弦を伴うローカルな測定方向を指定することができます。 

新しいモーダル・パラメータ・エクストラクターのアプレット 

モーダル・パラメータ・エクストラクター（MPE）は、対話形式で使用可能な新しいアプレットを特色とし

ます。このアプレットには次の新しい機能が追加されます。 

• 対話形式のリファレンスとレスポンス選択（アプレットのみ） 
• 周波数領域の実稼動シェープ・ビューアー（アプレットのみ） 
• 複数の周波数帯選択およびポール（極）のコンビネーション（アプレットのみ） 
• 自動MAC、複素モード解析、FRF再シンセシス、アニメーション・モードシェープ・プロットによる抽出

モードシェープの検証 

MPEアプレットは、メイン・メニューから、Add-ons > Modal Parameter Extractorを選択するか、コンソー

ル・ウィンドウ底部のコマンド・エントリ・ラインにMPE GUIコマンドを入力することによりオープンされ

ます。 

MPEアプレットは3つのタブがあります。 

• FRF Explorer  
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• Poles Extraction  
• Modes Extraction  

FRF エクスプローラ・タブ 

MPEアプレットの第1タブは、データベースに存在するすべてのFRFをコントロールし、またテスト・モデル、

FRFプロットを表示します。データを検査し、モーダル・パラメータを抽出のために使用するFRFを選択する

ことができます。 

実稼動モード解析では、FRF がクロスパワー・スペクトル（XPS）を表わすことに注意してください。次の

セクションでは、特定の FRF のみが FRF と XPS の両方を表わすために使用されます。                       

 

 

図1:FRFエクスプローラ・タブ 

References（参照）セクションは、すべての参照リストを提示します。テーブルのチェックボックスのチェッ

クにより希望の参照ポイント/DOFを選択してください。テーブル上のポップアップ・メニューはすべてのレ

スポンスの選択/非選択のオプションを提供することに注意してください。データを検査するためにテーブル

をブラウズすることができます。選択された参照データは紫色で強調され、メッシュ・プロット上でも紫色

の矢印で表示されます。 

Responses（レスポンス）セクションは、すべてのレスポンス・ポイントを提示します。テーブルのチェック

ボックスのチェック、あるいは、Select Responses ダイアログボックス（テーブル上のポップアップ・メニュ

ーから、Selectを選択）をオープンすることにより希望のレスポンスを選択してください。データを検査する

ためにテーブルをブラウズすることができます。選択されたレスポンス・データは緑色で強調され、メッシ

ュ・プロット上でも緑色の矢印で表示されます。 

メッシュ・プロットは、カーブ・プロットのトラッカーによって定義された周波数の選択参照点での実稼動

変形シェープ（ODS:Operational Deflection Shape）を示します。トラッカーは対象の周波数を選択するために

カーブ上をX軸に沿って移動さることができます。 

変形のスケールとメッシュのアニメーション速度は、スライドバーでコントロールすることができます。

Show Undeformed のチェックによって、変形前（オリジナル）のメッシュを加えることができます。さらに、

Solid View チェックボックスによりテスト・グリッドのワイヤーフレームに厚さを加えることができます。 
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図2：テストモード：ワイヤーフレーム・ビュー（左）とソリッド・ビュー（右） 

カーブ・プロットは、選択された参照とレスポンスのポイント/DOF間のFRFあるいは実稼動モード解析の場

合はXPSを示します。FRFのプロット方法は、プロットウィンドウ上部のドロップダウンリスト（magnitude, 
phase,など）から選択することができます。Show all active FRFs/XPSチェックボックスをチェックすることに

より、すべてのFRFを表示することは可能です。現在選択されているFRFはカラーでプロットされ、他のFRF
は灰色になります。そのカーブ上のトラッカーをドラッグすることによって、その任意の位置のFRFレベル

の数値を得ることができます。 

 

図3：アクティブFRFのプロット 

Poles Extraction（極の抽出）タブ 

Poles Extraction タブは、テストデータの極を推定します。 

 

図4：Poles Extraction タブ 

Poles Extraction は次の3つのパラメータを必要とします。 

• Maximum Order（モデル最大係数）：安定化チャートを作成するために使用するモデル最大係数。この

デフォルト値は対象の周波数レンジのピークの数から推定されます。 
• Minimum Frequency（最小周波数）：対象の周波数レンジの下限値。最小周波数は編集ボックスに値を入
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力するか、FRF積算プロット上の周波数選択の下限のマーカー（青色の正方形）のドラッグによって指定

することができます。周波数選択範囲の内部のドラッグによって、選択周波数を変えることができます。

即ち、最小と最大の周波数の両方を移動させることができます。 
• Maximum Frequency（最大周波数）：対象の周波数レンジの上限値。最大の周波数は編集ボックスに値を

入力するか、FRF積算プロット上の周波数選択の上限のマーカー（青色の正方形）のドラッグによって指

定することができます。 

Show Stabilization Settings ボックスのチェックによって、さらに高度なパラメータをカスタマイズすること

ができます。 

• Minimum Damping Ratio（最小減衰比）：この最小値は安定した極値を得るめの許容減衰値です。 
• Maximum Damping Ratio：この最大値は安定した極値を得るための許容減衰値です。 
• Maximum Frequency Consistency（最大周波数安定化係数）：この最大値は安定的と仮定される2つの連続

モデル係数の極間の周波数変化許容値。 
• Maximum Damping Consistency（最大減衰安定化係数）：この最大値は安定的と仮定される2つの連続モ

デル係数の極間の減衰変化許容値。 
• P. Factors MAC Consistency（MAC安定化刺激係数）：この最大値は安定的と仮定される2つの連続モデル

係数の極間の刺激係数変化許容値。 

エクストラクターを起動するには、Extract Poles ボタンをクリックしてください。FRFエクスプローラ・タ

ブ中で選択された参照（references）とレスポンス（responses）のみエクストラクターによって使用されます。 

安定化ダイアグラムが構築され、識別されたPoles（極）は、Polesテーブルにリストされます。安定的と仮定

されるPolesのチェックボックスは、指定された安定化セッティングによって自動的にチェックされます。ま

た、安定的なPolesは安定化ダイアグラム上に垂直な赤線で示されます。Poles チェックボックスによって、

極を選択することができ、Store Poles ボタンをクリックし、最終的に選択された極を保存することができま

す。 

希望に応じて、周波数選択（最小周波数と最大周波数）を修正し、追加される周波数バンドを選択すること

ができます。新しい周波数バンドで極を抽出（Extract Poles）し、極の選択に対象の極を追加（Store Poles）
してください。 

Clear ボタンによって格納された極データを削除することができます。 

Modes Extraction（モード抽出）タブ 

Modes Extractionタブは、格納された極データからモードシェープを抽出するために使用します。 

 

図5：Modes Extraction タブ 
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モードは抽出過程の第2ステップ間で格納された極のすべてを使用して抽出されます。対応するオプションの

選択により複素モードシェープの実数を抽出することができます。テーブルには抽出されたモードが提示さ

れます。 

• Mode #：モード番号 
• Frequency：モード周波数.  
• Damping：モードのモード減衰比  
• MPC：モードの複素位相 
• MPD：モードの位相偏差  
• MAC Alias：MACの非対角項の最大値 

テーブルで選択されたモードは紫色で強調されます。他のモードは選択されたモードに関して最大の非対角

項値とする色で強調されます。選択されたモードシェープはメッシュ・プロットに示されます。また、カー

ブ・プロットのトラッカーは選択モードの周波数に置かれます。マトリックス・プロット・インターフェイ

スにはモードを確認する5つのプロット方法が提供されます。 

• Modal Part. Factors：参照したすべてのモードのモード刺激係数を示します。 
• Auto-MAC：抽出モードのAutoMACを示します。 
• Auto-COMAC：抽出モードのAutoCOMACを示します。 
• Complexity Plot：極形式でモード変位をプロットし、複素モードシェープを視覚化します。 
• Damping：周波数応答関数の減衰の変化を示します。 

a  b  c  

d  e  f  

図6：a）モードシェープ、b）モード刺激係数、c）Auto-MAC、 
d）Auto-CoMAC、e）複素プロッ、f）減衰プロット 

ソリューション結果からモードを取り除くには、テーブル中の対応するチェックボックスを解除し、Extract 
Modesボタンをクリックすることにより、選択された極を使用したモードを再抽出します。モードの抽出が

終了すると、グラフィックス表示は自動的に更新されます。 

FRF Explorerタブで選択されたレスポンスを使用するには、Limit mode extraction to selected response DOFs
（選択レスポンスDOFのモード抽出）チェックボックスをチェックしてください。それがチェックされない

場合、極の抽出は選択されたレスポンスだけを使用し、DOFはすべてのモード抽出のために使用されます。

モードの抽出をテスト構造のある部分のみ制限する場合にもこのオプションが使用できます。 

抽出モードをすべて削除するために、Clearボタンをクリックし、Ploes Extractionタブに戻って再実行するこ

とができます。 
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レポーティング 

Capture ボタン（     ）のクリックによりMPEのグラフィックスのすべてをエクスポートすることが

できます。これは選択されたグラフィックス・ウィンドウとの対話を開始します。そのウィンドウのエッジ

をドラッグすることによりウィンドウ・サイズ変更し、グラフィック・サイズを定義することができます。

また、底部左隅の編集ボックス中にピクセル表現のサイズを入力し、グラフィックをサイズ変更するために

Applyボタンを押すことができます。Copyボタンを押すことによりクリップボードにグラフィックをコピー

することもできます。 

MPEアプレットに戻るには、Closeボタンを押してください。 

MPE のクローズ 

MPEを閉じるには、Exitボタン（    ）を使用します。 

MPEで抽出されたモードは、テスト・データベースに自動的に格納されます。 

パデ近似法によるFRFの計算 

パデ近似を使用すると、モーダル・アプローチ（高速性）と直接的アプローチ（不断性、減衰モデル対応）

の利点を組み合わせが可能になります。 

パデ近似プロセスはFRF周波数レンジを分割し、いくつかの小さな周波数バンドでのすべての周波数ライン

のソリューションへ拡張するために各バンドの中心を含むオーダー数nまでの直接的FRF勾配を指定する直

接的FRFソリューションを使用します。これは直接的ソルバー回数の縮小に帰着します。実際、200倍の改良

速度がパデ近似法の使用により得ることができます。また、すべての周波数ラインでの直接的ソリューショ

ンと比較しても精度の損失は非常に小さなものです。 

構造システム・マトリックスがテスト・モデルに利用できない場合には、パデ近似アプローチは利用できま

せん。 

パデ近似の精度は、次の2つのセッティングによってコントロールされます。 

• 使用するバンド数：バンド数は、3以上であるべきです。（デフォルト=8） 
• 使用するFRF勾配オーダー数：そのオーダー数は、3以上であるべきです。（デフォルト=5） 

実験は精度と計算速度の最適なセッティングの妥協点が必要とされます。これはパデFRF近似法とFRFの直接

的解法を比較することで得ることができます。 

パデ近似を使用して周波数応答関数を計算するには、 

• PADEFRF コマンドを使用する。  

パデ近似法はFEデータと要素マトリックス・ベースで処理され、モードシェープは必要としません。

PADEFRFを使用する前に、周波数レンジ（DEFINE RANGE）、加振と応答のDOF（DEFINE FRF）を定義

する必要があります。 

FRFベース・アセンブリ 

FEMtools 3.6は、FRFベース・アセンブリという動解析用の新しいツールを導入します。 

FRFベース・アセンブリ（FBA）は、複数のサブ・コンポーネントを組み合わせる動的サブストラクチャリ

ング法（部分構造合成法）であり、計算上のFRFあるいは各コンポーネントの測定データからアセンブリ・

レスポンスを推定します。FBAの場合はアセンブル構造の計算された振る舞いと同様にサブ・コンポーネン
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トの動的特性も周波数応答関数（FRF）で記述されます。FBAは構成要素のモード・シンセシス（スーパー

要素：CMS）やモード・ベース・アセンブリ（モードシェープのみの使用）に取って代わります。 

イントロダクション 

動的サブストラクチャリング法は、構造系を別々に解析し、その後、アセンブリ手続きによってそれらを組

み合わせることができるサブパーツに分割する方法です。このような方法はダイナミック・モデルの複雑さ

やサイズを縮小するために使用されます。 

コンピュータの能力は、大規模問題の解析において過去数十年間で著しく増大し、複雑なモデルの処理やサ

ブストラクチャリング技術もまた、それぞれの異なるサブグループの開発事業を広げることを可能にする上

において非常にポピュラーです。さらに、モデルがますます複雑（自由度数および物理的モデル化の点から）

なり、その縮小技術をサポートすることは、例えば、最適化や確率論的解析にとっても有益です。サブスト

ラクチャリングの概念は、効率的な並列計算の基礎となる領域分解法と大きく関係します。 

FRFベース・アセンブリ（FBA）は、各サブシステムが自由なインターフェイスの独立した系の周波数応答

関数（FRF）で表される周波数領域法です。このような方法は周波数ベースのサブストラクチャリング（FBS）
として知られています。 

FBAは、モデルベースのサブストラクチャリング（スーパーエレメント）やモード・ベース・アセンブリ（MBA）

アプローチ（モーダル･カップリングあるいはモード・シンセシス）のようなサブストラクチャリング法に取

って代わります。 

FBAは、コンポーネント間のカップリングに着目し、多くのコンポーネントを備えたより大きなアセンブリ

の最適化や接続による力の伝達の研究に有効な計算方法です。 

FEMtoolsのFBAアプリケーションのいくつかは次のとおりです。 

• アセンブリ構造の動的応答シミュレーション 
• アセンブリFRFによるモーダル・パラメータの抽出（FEMtools MPE参照） 
• 任意の入力パラメータによる応答効果解析（感度解析） 
• ボトム・アップFEモデルの検証とモデルアップデート 
• 修正済の境界条件あるいは追加質量のテスト構造のFRF生成。これらはマルチ・モデルアップデートにお

ける参照レスポンス数を拡大し、構造ヘルス・モニタリング用のダメージ識別アプリケーションのために

使用することができます。 
• 構造ダイナミクスの最適化（FEMtoolsの最適化参照） 

FBAはNVHの伝達パス解析をリードします。この主題は、将来のFEMtoolsのリリースにも反映されます。 

FBA の利点と欠点 

サブストラクチャリング法は解析データすなわち有限要素モデル、実験データが使用されます。実験のサブ

ストラクチャリング法には多くの利点があります。 

• 解析的にモデル化された解析データと実験コンポーネントの実験測定データを組み合わせる可能性を与

えます。実験と解析のモデルを組み合わせることはハイブリッド解析と呼ばれます。 
• それぞれのプロジェクト・グループの部分構造を共有し結合することを可能にします。 
• 部分構造が変更される場合、動的サブストラクチャリング法はダイナミクスの完全系を迅速に推定します。

あらためて変更された部分構造を測定するか再解析することにより、効率的なローカルの最適化、迅速な

設計サイクル、全面的な最適化などが可能となります。 
• 部分構造のモデル化が複雑で、ローカルの最適化が困難な場合、それに代って実験データが有効です。そ

の場合、FEモデリング、検証、モデルアップデートのプロセスはそのコンポーネントに代って実験データ

が使用されます。より多くの時間を最適化する部分の適切なモデリングに集中させることができます。 
• 構造は大規模なため構造物の全体を十分に測定できなかったり、構造が複雑なため、それぞれの部分構造

には適切な加振は可能だが、全体構造には十分な加振エネルギーが与えられない場合、動的サブストラク
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チャリング法は有効です。 
• 構造全体のテストでは見つからないローカルな問題を容易に検査することを可能にします。 

実験データを考慮する場合、FBAはスーパー要素法とMBAに関するいくつかの長所を使用します。 

• 実際の周波数応答関数を使用します。それはモード解析で生じる誤差や推定されなかった高次モードの誤

差の回避を暗示します。 
• 実験データは構造の実際の物理的な現象を示し、古典的モデル合成アプローチでは表せないFRF測定に含

まれている周波数上のダイアナミクス構造の性質（粘弾性材料など）が表せます。 
• 利点と同時に、FBAはいくつかの欠点を持っています。 
• 適用範囲は、通常、一定のパラメータを備えた静的線形システムに制限されています。 
• FRFの測定データとしては、通常、並進自由度に制限されています。回転自由度の測定データや拘束方程

式の使用による回転DOFの導入については検討中です。 
• ノイズを含むFRF測定データが使用されます。FBAは複素因数分解、転置、FRF演算などの機能を含んで

います。さらに、FBAアルゴリズムには、完全系に影響する測定ノイズを除去するための逆行列演算が必

要です。そのような理想的な測定データを得るためにノイズ除去を適用することは不可欠です。 
• 解析的FRFの計算には、モーダル法あるいは直接法が使用されます。モーダル法は高速ですが、モードの

未検出などの問題があり、直接法は計算時間の問題があります。この問題を解決するためパデ近似法が

FEMtoolsで採用されました。パデ近似法は、直接法のFRF計算速度のおよそ50～200倍の計算速度で要求

される精度を達成します。 

FEMtools の FBA 法 

FEMtoolsに搭載されるFBA法はラグランジュ乗算周波数ベースのサブストラクチャリング法（LM FBS）です。

LM FBSに関する文献については、[1]の論文から参照できます。LM FBS法は、[2]で議論されているように、

古典的理論と等価ですが、より容易な機能と効率的な使用法が示されています。 

FBAは将来のFEMtoolsリリースで導入される伝達パス解析（TPA）に拡張することができます。TPAは、コ

ンポーネント、コネクタおよび支持物のNVHデザインや最適化のために使用されます。 

文献 

[1] Dennis de Klerk, Daniel J. Rixen and Jasper de Jong, “The Frequency Based Substructuring (FBS) Method 
reformulated according to the Dual Domain Decomposition Method”, Proceedings of the 24th International Modal 
Analysis Conference, 2006.  

[2] Jetmundsen, B., Bielawa, R. L. and Flannelly, W. G., Generalized Frequency Domain Substructure Synthesis, Jnl. 
American Helicopter Society, Vol. 33, No. 1, pp. 55–64, 1988.  

FEMtools FBA の使用方法 

FBAプロセスは、個々のコンポーネントのFRFとしてのアセンブリ計算FRFです。 

周波数応答関数（FRF）は、指定されたDOFへの単位荷重と応答の関係によってコンポーネントを表わしま

す。FBAに起因するFRFはユーザーによって定義された荷重（単位荷重ではない）への周波数応答を得るた

めに使用することができます。 

コンポーネントは、Boundings（バネ）やJoints（継ぎ手）のような特別なFBAコンポーネントによって設定

されます。 

• Boundingsは、付加質量、外部スプリング、吸収器などの境界条件をモデル化するため、1つの節点に付加

物として定義される外部コネクタです。それらはスプリング、インピーダンス、質量を参照付けることが

できます。 
• Jointsは、2つのコンポーネントの接続や慣性モデルの接続を定義するために2つの節点間に付加される弾

性や剛性のカップリングです。それらはスプリングやインピーダンスを参照付けることができます。Joints
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も周波数特性を定義することができます。 

Impedances（インピーダンス）は、ローカル座標系をサポートし、粘性減衰（ダッシュポット）や構造減衰

（GE）として定義することができます。それぞれのboundingsやJointsには同一インピーダンスに参照付ける

ことができます。 

Masses（質量）は、オフセット、クロス慣性、ローカル座標系をサポートする集中質量や質量慣性（(mx, my, 
mz, jx, jy, jz) です。それぞれのboundingsには同一質量に参照付けることができます。FEMtools RBPEはFRF
から剛体特性を得ることができることに注意してください。FBA質量は、boundingsに割り当てることができ、

集中有限要素質量と混同してはならない特性であることに注意してください。集中質量としてアセンブリで

導入された部分構造は、他のコンポーネントと継ぎ手のような関係で、個別のFBAコンポーネントとして扱

われます。 

Intra model connector（慣性モデル接続）は、スプリングあるいはダンピングをモデル化するために使用する

ことができ、コンポーネント内の2つの位置間に挿入されます。 

 

FEMtools FBAの概略 

最終のアセンブリにおいて、boundingsが含まれていないフリー状態の各コンポーネントのFRFを計算するか

測定することが推奨されます。フリー条件を使用すると、boundingsをFBAプロセスで追加することができま

す。ただし、既にコンポーネントの一部の境界条件は削除することができません。 

最後に、FBAは、アネンブリ構造上のターゲットFRFの定義を必要とします。それらは、構成要素の識別番

号、節点および自由度（DOF）を各々参照する外力（加振）および応答ポインの点から定義されます。 

そのインターフェイスのDOFには応答と加振の同一（AND）DOFが使用されるべきです。あらたに外力を与

えたり、応答を得るために追加するDOFの位置は、インターフェイスDOFとその追加DOFの間のFRFである

べきです。 

FRFのセットは、FEMtools内部FRF計算コマンドで計算され、あるいは、外部ファイル（例えば、実験のFRF
ではユニバーサル・ファイル）からインポートされます。FRFの各セットは構成要素のモデルに一致します。

また、そのFRFはFEMtools内部データベースの各セクションに格納されます。 
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実際的なアプリケーション 

以下に典型的なワークフローを示します。 

1. コンポーネントを識別し、boundings、joints、外力、応答ポイントの位置に一致するFEまたはテストのモ

デル上の節点とDOFを選択してください。コンポーネントが関連するFRFデータ・ファイルのテスト・モ

デルである場合、そのDOFとFRFはインポートプロセスによって定義されます。解析的なモデルの場合に

は、そのFRFはDEFINE FRFコマンドを使用するか、FRF定義テーブルで定義されます。 
2. 解析的なFRFは、FRFまたはPADEFRFのコマンドで計算します。それには、モードの未検出による不正確

なシミュレーションを回避するために直接法あるいはパデ近似法を使用します。 
3. boundingsとjointsを定義してください。 
4. 外力と応答のポイントを定義します。 
5. 応答と外力のポイント間のFRFを計算するためにFBAソルバーを実行してください。 

FRFのタイプは、任意のタイプ（displacement/force, accel/force, velocity/force ）でありえますが、周波数レン

ジは、アセンブリされるすべてのFRFについて同一であるべきです。 

FBAは、FRFの計算にモード法を使用する場合、FRFデータ（実験）中のノイズやモードの未検出の要因とな

るプロセスです。一般に、モードの未検出は、正確なシミュレーション機能を低下させます。この問題はFBA
プロセスにとって非常に有害な場合があります。したがって、直接法のFRFの計算が有効となります。 

一般に直接法によるFRFの計算速度は遅いですが、FEMtoolsのパデ近似法によって高速化することができま

す。詳細については本マニュアルの周波数応答関数を参照してください。 

パデ近似プロセスはFRF周波数レンジを分割し、いくつかの小さな周波数バンドでのすべての周波数ライン

のソリューションへ拡張するために各バンドの中心を含むオーダー数nまでの直接的FRF勾配を指定する直

接的FRFソリューションを使用します。これは直接的ソルバー回数の縮小に帰着します。実際、200倍の改良

速度がパデ近似法の使用により得ることができます。また、すべての周波数ラインでの直接的ソリューショ

ンと比較しても精度の損失は非常に小さなものです。 

コマンド 

FBAツールは以下のコマンドに基づいて、使用することができます。 

FBA FRFベース・アセンブリ処理 

DEFINE FBA BOUNDING FBA boundings を定義する。 

DEFINE FBA FRF FBA FRFs を定義する。 

DEFINE FBA IMPEDANCE FBA joint impedances を定義する。 

DEFINE FBA JOINT FBA joints を定義する。 

DEFINE FBA MASS FBA システムに質量を加える。 

DEFINE FBA MODEL FBA コンポーネントを定義する。 

DEFINE FBA TABLE FBA テーブルを定義する。 

CLEAR FBA FBA データを削除する。 

EXTRACT FBA FBA データをリストする。 
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FBAと共に一般に使用される他のデータベースと解析のコマンドを以下に示します。 

MOVE FEM 参照 FE モデル（id=1）から別のモデルにデータを移動させる。 

INPUT FRF 外部ファイルからFRFをインポートする。 

DEFINE RANGE 周波数応答解析に対する一連の周波数値を定義する。 

DEFINE FRF FRF を定義する。 

FRF モード重ね合せ法を使用し、FRF を計算する。 

DFRF 直接法を使用し、FRF を計算する。 

PADEFRF パデ近似法を使用し、FRF を計算する。 

さらに、オンラインHelpドキュメントの各コマンドのリファレンス情報を参照してください。 

例題 

FBAの例題については、FEMtoolsダイナミクス・ユーザーガイドを参照してください。 

時間領域シミュレーション 

FEMtools 3.6は時間領域シミュレーション（動解析用の新しいツール）を搭載します。 

時間領域シミュレーション（TDS:Time Domain Simulation）技術は付加荷重関数による構造の過渡応答を計算

することが可能です。FEMtools TDSソルバーは、最初に構造物の正規モードから定常空間モデルを推定し、

次に、応答の時系列を計算するためにこのモデルを使用します。そのため、TDSソルバーは新たなFEソルバ

ーを必要としない、計算上において効率的な方法で過渡応答解析が可能になります。 

FEMtoolsモーダル・パラメータ・エクストラクター（MPE）と統合し、TDSのモジュールをプリテスト解析

ツールとして使用することができます。TDSのモジュールは、測定チャンネル（時系列データ）の直接の出

力でデータを使用することができます。したがって、プリテスト解析は実際の測定データのシミュレーショ

ンによる完全なテスト手順を評価するために使用することができます。 

状態空間モデル 

構造物の時間応答は個別の状態空間モデルを使用して計算されます。 

 
kkk

kkk

DuCxy
BuAxx

+=
+=+1  (1) 

 

ここで、uは個別の入力信号を表し、yは出力信号を表わします。また、kはサンプル・インデックスを表わし

ます。状態ベクトルxkは、kのサンプルのための変位や速度を含んでいます。マトリックスA、B、C、Dは状

態空間モデルを表わします。Aは各状態マトリックス、Bは各入力マトリックス、Cは各出力マトリックス、

また、Dは各ダイレクト伝達マトリックスです。 

状態空間モデルは、構造物のモーダル・パラメータに基づきます。 
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Ω2が共振周波数の正方形を含むところで、Γは減衰係数を含みます、Ψはモードシェープ、B2は入力外力の位

置を定義します。また、そのDOFでは変位、速度、加速度を計算するCd、Cv、Caは示します。 

構造物のモーダル・パラメータから、状態空間モデルを式（2）で導き出すことができます。入力シーケンス

ukのための時系列データの生成によって、応答シーケンスは、各サンプリング・ステップの式（1）から計算

することができます。 

文献 

[1] Juang J.-N., Applied System Identification, Prentice Hall, Englewood Cliffs, NJ,  
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[2] Peeters B., De Roeck G., Stochastic subspace system identification of a steel transmitter mast, proceedings of 
IMAC 16, the International Modal Analysis Conference, pp. 130-136, Santa Barbara, CA, USA, February 1998.  

FEMtools のインプリメンテーション 

時間領域シミュレーション（TDS）モジュールはコマンド・ベースのツールです。 

TDS 信号 

各入力と応答については、TDSの信号を定義しなければなりません。TDSの信号としては、入力/応答の位置

（節点）、入力/応答の方向（DOF）、信号のタイプ（力、変位など）を格納します。TDSの信号は、DEFINE 
TDSSIGNALコマンドで作成されます。 

セッティング 

時間領域シミュレーションは、2つのセッティングを必要とし、それは時間ステップ、シミュレーションの長

さです。それらの量は秒単位で表現されます。時間ステップは、2回のサンプル間の間隔を定義します。時間

ステップはサンプリング周波数の逆数です。信号の周波数はサンプル周波数の半分に制限されていることに

注意してください。時間ステップはコマンドSET TDSのSTEPで定義されます。 

シミュレーションの長さは、シミュレートする時間間隔を定義します。計算時間サンプルの数は「シミュレ

ーションの長さ」×「時間ステップ」に等しくなります。シミュレーションの長さはコマンドSET TDS LENGTH
で定義されます。 

入力信号 

TDSのソルバーを開始する前に、構造物に適用する荷重の時系列データを生成しなければなりません。入力

信号の生成はTDSのセッティングを必要とします。したがって、入力信号の時系列データが生成される前に、

それらを定義しなければなりません。TDSのモジュールは単に入力量として、外力を設定します。生成でき

るデータには、3つのタイプの入力信号があります。 

• Impulse：指定された振幅と時間ステップにおけるインパルス（1回のサンプル）を生成します。 
• Sine：指定された周波数と最大振幅に基づく正弦波を生成します。 
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• Random：指定されたRMS振幅の白色ノイズシーケンスを生成します。サンプル値は一定分布とガウス分

布の選択が可能です。 

入力信号の時系列データは、TDS GENERATEコマンドで生成されます。 

応答信号 

応答信号はTDS COMPUTEコマンドで計算され、変位、速度、加速度の3つの量が指定できます。応答信号

の時系列データを計算する前に構造物のモードシェープ、共振周波数、減衰比が定義されていなければなら

ないことに注意してください。 

時系列データのプロット 

時系列データは、TDS PLOTコマンドあるいはデータベース・エクスプローラのGraphics > XY – Curves セ
クションの適切な信号をダブルにクリックすることによりプロットすることができます。 

プリテスト解析 

TDSシミュレーションの出力は、TDS CONVERTコマンドでモーダル・パラメータ・エクストラクター（MPE）
データベースにコピーすることができます。このコマンドは時系列データをコピーし、実稼動モード解析用

のチャンネル定義を生成し、測定ポイントを生成します。トレースライン情報がTDSのデータベースにおい

て利用できない場合には、トレースラインを生成しません。時系列データからのモーダル・パラメータを推

定するには、FEMtools MPEライセンスが必要であることに注意してください。 

コマンド 

TDSツールはコマンド・ベースです。以下のコマンドが利用できます。 

DEFINE TDS SIGNAL TDS の時間領域シミュレーション信号を定義する。 

SET TDS  TDS のセッティングを指定する。 

TDS GENERATE TDS の入力信号を生成する。 

TDS COMPUTE 時間領域レスポンスを計算する。 

TDS PLOT 時間領域シミュレーション信号をプロットする。 

TDS CONVERT モーダルパラメータ・データベースに TDS 応答をコピーする。 

例題 

TDSの詳細な例題については、FEMtoolsダイナミクス・ユーザーガイドを参照してください。 

相関解析 

MAC寄与度解析（MCA）は、非対角項の値によるビューを改善するために「ダイヤモンド」ビューを使用し、

MACマトリックスをプロットします。 

モデルアップデート 

TUNEコマンドに各モデルアップデート反復計算の終わりにカスタム・スクリプトを実行することを可能に

するための補語が追加されました。そのFEMtoolsプログラム・スクリプトは、SET TUNE ISCRIPTコマンド
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を使用し、モデルアップデート手続きに加えることができます。 

この機能は、examples/updating/disk_modal/ directoryのrun08_iter.basを参照し、例証することができます。 

最適化 

データベース・エクスプローラの最適化マトリックスのポップアップ・メニューには、データベースからマ

トリックスを取り除くための Clear Matrixエントリがあります。 

 

FEMtoolsコマンド 

FEMtools 3.6コマンド言語にはいくつかの新しいコマンドが拡張されました。また、既存のコマンドも強化さ

れました。より詳細については、FEMtools HelpのFEMtools Command Referencを参照してください。 

新しいコマンド 

セクションでは、FEMtools3.6のリリースに伴う新しいコマンドについて解説します。 

CLEAR FBA FBA データを削除する。 

DEFINE FBA BOUNDING FBA boundings を定義する。 

DEFINE FBA FRF FBA FRF を定義する。 

DEFINE FBA IMPEDANCE FBA joint インピーダンスを定義する。 

DEFINE FBA JOINT FBAjoints を定義する。 

DEFINE FBA MASS FBA システムに質量を加える。 

DEFINE FBA MODEL FBA コンポーネントを定義する。 

DEFINE FBA TABLE FBA テーブルを定義します。 

DEFINE TDS SIGNAL TDS 時間領域シミュレーション信号を定義する。 

EXAMINE DIRCOS 座標系あるいは測定センサーの方向余弦を計算する。 

EXPORT MATRIX 内部 FEMtools マトリックスをファイルにエクスポートする。 

EXTRACT FBA FBA データをリストする。 

FBA FRF ベース・アセンブリを実行する。 

IMPORT MATRIX ファイルからマトリックスをインポートする。 

MODIFY MATERIAL 材料特性を修正する。 

MODIFY GEOMETRY 幾何学特性を修正する。 

MOVE MODEL あるモデルから別のモデルにデータを移動する。 
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PADEFRF パデ近似法を使用し、FRF を計算する。 

PRETEST CLEAN プリテスト解析後の FE モデルを消去し、不要になった座標系も消去す

る。 

PRETEST MOVE 手動センサー選択解析でセンサー位置を移動する。 

PRETEST REPORT  方向余弦を伴うローカルな測定方向を示す。 

SET TDS  TDS のセッティングを指定する。 

TDS COMPUTE 時間領域レスポンスを計算する。 

TDS CONVERT モーダル・パラメータ・エクストラクター・データベースにTDSのレ

スポンスをコピーする。 

TDS GENERATE TDS の入力信号を生成する。 

TDS PLOT 時間領域シミュレーション信号をプロットする。 

修正済のコマンド 

このセクションは、FEMtools 3.6のリリースで変更されたコマンドについて解説します。 

EXAMINE SEAMAC センサー位置の固定を定義するための補語FORCEDが追加されまし

た。 

節点選択を指定するための補語NODEが追加されました。 

非対角項のMAC値のターゲット値を指定するための補語

OFFDIAGONALが追加されました。 

補語TARGETは2つの値を要求します。 

MESH PIPE … 補語PIPEはソリッドのパイプ・スタイルのワイヤーフレーム・メッシ

ュを表示する。 

NOISE 補語FREQUENCYが追加され、共振周波数にノイズを加える。 

PRETEST ADD 補語 MODE が追加され、手動のセンサー選択の準備ができているモー

ドを選択する。 

 補語MACUPDATEは、MACの自動再計算のスイッチとして追加され

ました。 

PRETEST REMOVE 補語MACUPDATEは、MACの自動再計算のスイッチとして追加され

ました。 

PRETEST REPORT 補語DIRECTIONSがローカルの測定方向が方向余弦を使用して表現

されるべきかどうか明示するために追加されました。 

SET TUNE 補語ISCRIPTが追加され、反復スクリプトを定義する。 

STRESS 補語NODALSTRESSが追加され、節点応力を計算する。 
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削除されたコマンド 

このセクションは、FEMtools 3.6リリースで削除されたコマンドについて解説します。 

LOAD MREC このコマンドは旧式になったため、IMPORT MATRIX と取り替えら

れます。 

PRETEST RESTORE このコマンドは旧式になったため、もはや存在しません。 

SAVE MREC このコマンドは旧式になったため、EXPORT MATRIX と取り替えら

れます。 

 

FEMtoolsスクリプト言語 

FEMtools 3.6のスクリプト言語は、いくつかの新しい機能で拡張されました。また、既存の機能が強化されま

した。より詳細については、FEMtools HelpのFEMtools Script Referenceを参照してください。 

新しい機能 

以下はこのバージョンに追加された新しい機能です。 

FileMD5 32デジットの16進ストリングとして128ビットのファイル名を計算し

返します。その名前はファイルのデータ保全をチェックするために使

用することができます。 

FileRead ファイルを読み、ストリング内容を返す。 

OpenFilenames ファイル・オープン・ダイアログボックスを使用し、ファイル名のリ

ストを返す。 

修正済の演算機能 

このセクションは、FEMtools 3.6のリリースに伴う既存のFEMtoolsスクリプト機能への変更について記述しま

す。 

Unique 例えば、B=Cut（A、IndexA）の場合、IndexAはインデックス情報を備

えたベクトル配列を返す新しいオプションの引き数です。 

 

FEMtools API 

FEMtools 3.6 APIはいくつかの新しい関数で拡張されました。また、既存の関数が強化されました。より詳細

については、FEMtools HelpのFEMtools API Referenceを参照してください。 

新しいFEMtools API関数 

Ft_GetPointCSMatrix ポイントの座標系の余弦座標系マトリックスを返す。 
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修正済FEMtools API関数 

このセクションでは、このリリースにおけるFEMtools API関数の変更について記述します。 

解析 API 機能 

Ft_MulEMat ダインピング・マトリックスとして、「B」（粘着性）と「C」（剛性

マトリクスの複素部）のサポートを加えました。 

API 機能のライセンス 

Ft_ProductInfo 属性として、「options」と「expiration」が追加されました。 

Ft_LicenseInfo 属性として、「options」と「line-item」が追加されました。 

データベース API 機能 

Ft_GetMat 自動的に抽出されたマトリックス名（matrix.name「cc」）はMSFを使

用したテスト・モードシェープのスケーリングを意味します。これは、

実験モードシェープのレスポンスが定義され、MACマトリックスが利

用可能な場合に有効です。 

Ft_GetMatList 新しいオプションの引き数が特別のエクスプローラ・グループの選択

するために追加されました。 

プロセス制御 API 機能 

Ft_Command  ジャーナル・ファイルに追加する必要はないことを明示するための新

しい引き数が追加されました。 

新しいAPI環境変数 

スカラーとストリング 

restart.requested プログラムが終了した後、FEMtoolsを再開する必要があることを明示

します。このセッティングはインストール手続きを自動化するために

使用することができ、FEMtoolsの再始動を要求します。 

tune.curiter 現在の反復ステップのインデックス（整数）を指定する。 

tune.iterscript 反復スクリプトの名前（ストリング）を指定する。 
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